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Installation Guidelines 

SemTalk minimum requirements: 

• Microsoft Visio® 2007, Microsoft Visio® 2010, Microsoft Visio® 2013   

We recommend using Microsoft Visio® 2010, Microsoft Visio® 2013 so that SemTalk 

functions as an integrated plug-in in Visio. 

• Microsoft .NET Framework Version 4.0 or higher. 

SemTalk will check to see if .NET is installed during installation.  If it is .NET is not installed, 

SemTalk installation will not proceed. 

o Download Link: (http://www.microsoft.com/downloads/) 

NOTE:  SemTalk’ s startup language will be set according to your system settings. To change your 

regional settings and system language please go to Window’s START  Settings   System control 

 Regional and language settings. 

You may also change the start language in SemTalk without modifying your computer’s regional 

settings. In SemTalk go to menu bar option Tools  SemTalk Options Language (Tab)  GUI 

Language and choose a language or the source of start language setting.

http://www.microsoft.com/downloads/
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What is SemTalk? 

SemTalk is a user-friendly editor for Semantic Web ontologies and processes. Because Microsoft 

Visio® is embedded in SemTalk; it combines the graphical strength of Microsoft Visio® with the 

consistency of a professional modeling tool.  

Using SemTalk, new modeling methodologies are easily defined for virtually any modeling problem. 

Applying a graphically configurable Meta model, Microsoft Visio® can be adapted to different 

modeling worlds such as CASE Tools, organizational models and object models. 

The main purpose of this tutorial is to learn how to use SemTalk.  This tutorial does not include 

detailed information about specific methodologies nor SemTalk Web or BPMN use cases. It also does 

not replace the Visio Tutorial.  This tutorial assumes readers are familiar with the basic Microsoft 

Visio® functions.  

If you are not interested in gaining a basic knowledge of SemTalk and just want to model processes 

using specific business process modeling methods such as CSA, EPC, BPMN, Promet and others). You 

can download specific tutorials for each of these methods from our web pages at 

http://www.semtation.de/index.php/en/manuals-en . 

Note:  SemTalk will open using the language specified in the currently installed operating system.  

Change system language settings in the Control Panel - Region and Language.  You can also use 

SemTalk Options - "Language" menu to change the GUI into another language supported by SemTalk.  
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Let’s get started 

There are two ways to use SemTalk.  The first, and recommended approach, is to install SemTalk, 

open Visio and use the SemTalk user interface embedded in Visio as a Visio Addin.  The second 

approach is to open SemTalk directly and use SemTalk.   The recommended approach, especially 

when using SemTalk with SharePoint, is to open Visio directly. Please make sure that you have 

installed the “SemTalk Add in for Visio 2010 / Visio 2013” before opening Visio.  However, if you are 

using Visio 2007, open SemTalk using the SemTalk icon on your desktop. 

 

In order to start SemTalk simply open Visio. The “New SemTalk” menu gives an overview of 

preinstalled templates.  Select “New” if you have Visio 2013 or 2010 and then select the Visio Work 

Flow Diagram.  If you have Visio 2007, please open the SemTalk application by double clicking on the 

desktop SemTalk icon or use “Start->Programs->SemTalk->SemTalk4”.  Then select “New SemTalk” 

and then select “no meta model”. 
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For this Tutorial we will not use a specific notation, rather we will use Visio’s Workflow Diagram from 

the Flowchart category. 
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Once SemTalk is installed, you can use Visio’s SemTalk as a Visio add-in, your user interface should 

look similar to the picture below.  Since SemTalk is embedded in Visio, window panes within the 

application can be “docked” to the borders of the Visio pane.  Move and size your Visio and Semtalk 

windows to dock them so that they look like the following picture. 

 

"SemTalk Explorer" appears in the left windowpane.  You will see a Visio drawing sheet (middle) 

associated with predefined shapes (symbols) in the object templates (templates) on the right side. 

The "SemTalk Explorer" displays the tree structure of all relevant model diagrams along with the 

objects and their relationships. If the SemTalk Explorer is hidden, view it by selecting the "Explore" 

button on the "Start" tab. 

SemTalk Explorer can also be opened by using the Explorer Button on the Home Tab. 

 

Structured access to objects contained in your model is available in the Explorer. 

Visio’s Pan & Zoom Window is located in the lower right corner: 
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A major advantage of using SemTalk for Visio is that you can customize the ribbon to match your 

modeling needs.  

Creating an Instance Diagram 

Instance diagrams model concrete things that have their own unique identity.  SemTalk uses Instance 

Diagrams for business processes, organization charts, data warehouse cubes, product models, etc.  

Virtually every Visio drawing contains graphics that represent "real", specific objects, whether a piece 

of kitchen equipment or a specific plan for your garden.  Diagrams representing a particular scenario 

are Instance Diagrams.  

Class Diagrams are the counterpart to Instance Diagrams. They contain abstract objects such as data 

types or class definitions that more broadly describe the characteristics of a general category. In the 

Visio world, Classes correspond to Master Templates vs. Instances of shapes that appear on a 

drawing page.  In a Class Diagram, the Visio master and their possible relationships are described. 

Class diagrams will be further described in the section "Class Diagrams" that appears later in this 

section. 
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You can begin modeling using the existing page with modeling or you can create a new page. 

      or          

Create a Diagram using the New –> Instance from the File pull-down menu or Right Click on the 

SemTalk Explorer – Diagram to create an " Instance Diagram".  Create your new Instance Diagram.  

When using the Explorer option, a new diagram will appear with a default name (e.g. Instance -4).  In 

the SemTalk Explorer a sub-folder Generic" will appear under Diagrams. Your new diagram will 

appear in the Generic Folder.  The Diagram Name can be changed by right mouse clicking on the new 

Diagram that appears in your SemTalk Explorer -> Generic folder or by renaming the Visio page by 

selecting the right click Edit menu when you are on the sheet tab at the bottom of the chart.  Change 

the name by selecting "Edit ".   The “Delete" option will delete the selected diagram. 

Creating an Instance 

First open a Visio stencil.  In this tutorial, we will use “Work Flow Diagram Shapes”. (Found in the 

section “Flowchart”). 

Now drag & drop the shape titled “User”.  Repeat this procedure to create a second “User” object.  It 

is also possible to use the Shape -> Search function that appears in the Shape Window pane.  The 

search option allows you to look for shapes already contained in your Visio® stencils.  Select Work 

Flow Objects. 

                

SemTalk automatically assigns a unique name to each object according to the Visio® stencil name. 

For example, “User.14” and “User.15 are different objects of the class “User”.  Double-click on the 

object to type in a new name.  In your new model change the User names to “John “and “Mary”. 
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Editing Objects1 

To change the object’s name or other properties, double-click on the shape or right mouse click on 

the object and select Edit.  

 

Add related documentation, either other file types or web links, by assigning or removing from your 

objects by using the ( ) or ( ) buttons in the lower left corner of the object’s Edit dialog box. 

Newly created objects in a diagram will also automatically appear in the SemTalk Explorer.  If there 

are associated Links, they will appear as a list under Attachments in the SemTalk Explorer or under 

"Objects → Attachment". 

                                                           

1 When we refer to "Objects", we are referring to both Instances and Classes in cases where it is not necessary 

to distinguish between the two. When the term “objects” is used, instructions apply to both Instances and 

Classes. 
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Note:  If necessary, change the zoom of the drawing sheet.  Zoom is located in the bottom toolbar in 

the lower right corner of your window.  Adjust the zoom slide bar so you can better read object 

names. 

If you have used Visio without SemTalk to create a specific User icon, you may have a series of 

already defined Users, such as User “Mary”.   Simply drag several symbols of type "Mary" into your 

diagram.   In Visio these symbols bear no relationship to those objects managed by SemTalk.  If you 

rename any of your icons, or change them to other symbols, this might give rise to changes  in other 

Visio pages.  Complex Visio models are difficult to maintain under these circumstances.  SemTalk 

makes the maintenance of complex models much easier to easily maintain model consistency . 

Consistency 

When duplicating a SemTalk object, it is necessary to maintain the consistency of the model.  For 

example, if the user modifies the name of an object, the modification must also occur in every object 

that has the same name. 

Please create a second shape for the Instance “John” by using Copy&Paste. (Ctrl-C, Ctrl-V) and 

rename it to “John Doe”.   When you change “John’s” name you will see that all occurrences of 

“John” will be updated to “John Doe” because both of these Visio shapes represent the same 

instance. 

 

Now, every modification done to the object “John” will be replicated in all “John” shapes.  
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Removing or Deleting an Instance 

 

It is important to point out that with Del-key, Ctrl-X or Object  Delete from Drawing you are only 

erasing the chosen shape from the drawing area, but not removing it from SemTalk’ s object base. If 

you want to remove an object from the drawing area AND from the object base of your model, you 

must use Remove from the right-mouse click context menu or Object  Remove the menu bar.  

Please right-click on one of the Instances of “John Doe” in your drawing area and select Remove.  

In this way, you removed all instances of the object “John Doe” from the object base.  This removes 

“John Doe”  from the active diagram page, as well as, from every other page in your SemTalk model. 

In SemTalk, there is a single step Undo command that can restore the removed object and its 

properties.  If you delete an object, you may restore it in your diagram(s) using Insert or drag it from 

the Explorer.  Use this undo to restore John Doe to your model. 

Other SemTalk model-based functions like Browse, Find and Expand are described later in this 

tutorial. 

Navigation 

SemTalk provides various navigation features described in detail in later sections: 

SemTalk 

Navigation 

Description 

Browse Navigation to the same and/ or related objects being 

used in the Visio documents 

Find String-based search in the model  

Expand Insertion of related objects into the actual diagram page 

Removing vs. Hiding (DEL) Objects  

In SemTalk a distinction is made between  

• deleting objects from the database and  

• hiding objects within a drawing: 

Hiding Objects in a Diagram / Drawing Sheet  

If you use the "Delete from Drawing” command in the Object tab or if you select an object within 

your diagram and use your Delete <DEL> key (in some system configurations you may need to use Fn 

+ Delete ), objects will be removed from the diagram but they will not deleted from the database.  

These objects can be reinserted back into your diagram at any time by selecting "Paste" when you 

right click on the drawing sheet. 
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Deleting Objects from the Database 

When  "Remove" is executed on an object by right clicking on the object and selecting  “Remove” or 

by selecting Remove in the Object tab or by the right click menu in the SemTalk Explorer, objects are 

deleted from the database. Therefore, all instances of the deleted object or relationship will be 

deleted from all drawings! Visio Undo is only available for the last command.   

             Remove from Database:                    Cut (Hidden) From Diagram: 

(All instances in the model are permanently deleted.)        Only the selected Object will be 

hidden. All other instances are visible. 

                                            

Note:  

Objects appearing in any diagram in the model can also be deleted using the SemTalk Explorer. Select 

the object in the Explorer and delete it by selecting the object you want to delete in the Explorer.  

Then, using the right mouse click menu, select “Remove”.  

To search and delete multiple objects that appear in any diagram, use the menu tab Object → Delete 

Multiple.  You can filter objects using classes to display any instances that are not used in any 

diagram 

Class Diagrams 

Class diagrams allow you to define the meaning of your Visio symbols.  For example, you can define 

that a user is a particular person.  Then you can identify what relationship this person has to a 

product or to the activities in the process you are describing. The definition of classes in SemTalk 

determines how instances of these classes behave in combination with other Visio shapes. Instance 

objects can only be connected to another object if this relationship is defined and allowed for the 

respective classes.  

Classes with specific attributes can be created, such as creating a class with an attribute called 

"Experience" to allow a user Class to inherit either the subclass "expert" or the subclass "novice".  

Abstract classes where no Visio master shapes are available can be assigned a general class symbol 

("Class").  For example, if there is no “Person” Visio® shape (yet), you can assign the general class 

symbol. 
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Creating a Class Diagram 

First, a Class Diagram is needed.  In SemTalk, there are two Generic diagram types - Class and 

Instance Diagrams. "Class" objects are located in Class Diagrams and "Instance" objects are located in 

Instance Diagrams.  

Select from the menu bar Diagram  New  Class Diagram or 

▪ Alternatively, you can create a new diagram directly from the SemTalk’s Explorer (tree structure).  

Right mouse click on the Diagram folder and select the option Class Diagram. 

 

Please change the diagram name to “My Classes”.  Now you are ready to create and insert classes.. 

Drag & drop the Visio master shape “User” onto the drawing area, a class “User” is created.  

Everything that you define for the class will also apply to any instances of this class.  For example, 

instances of Users may be real users such as "John" and "Mary".   Everything you define for the  class 

“User” will also be valid for any of its instances such as the "John" and "Mary" you created earlier 
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Adding a new class where there are no predefined Visio® Master Shape is very easy.  Please drag the 

“class” symbol from the stencil and drop it on the drawing area. Just write a name on the shape or 

right click and select Edit to create your new class. For example, give your new shape the name 

“Expert”. 

In the next sections, you will learn how to edit classes and instances. The term “object” will represent 

both classes and instances. In most cases, the edit dialogs are the same for both.  Exceptions are 

highlighted. 

 

NOTE:  Edit a class and/or its properties in the following ways: 

1. Double-click on the object or,  

2. Right mouse click and choose Edit from the context menu or, 

3. From the menu select Object  Edit  or, 

4. Find the object in the Explorer as a child of Diagrams  Generic  My Classes (context 

menu) or 

5. Find the object in the Explorer as a child of Objects (context menu). 
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Editing Objects  

Next, we will change the properties of the objects. 

 

Name The name of the object. You may change this name to specify the class name. 

Namespace The namespace of the class name for the object. The identifier of an object is the 

combination of a namespace and the name. E.g., “Tr#Treasurer” is the object 

named “Treasurer” in the namespace “Tr”. There might be another object 

“Hu#Treasurer” which is also displayed as “Treasurer”. Use each name only once 

in a namespace. You can precisely define an object companywide or even 

worldwide by combining of the name of an object and a Namespace, e.g. like this: 

"http://www.SemTalk.com/banking#Bank". Each name can only be used once in a 

namespace. 

Comment The description or definition of the class. 

Language To specify the language of a comment. Objects may have multiple names in 

different languages and multiple comments. 

Hyperlinks E.g. hyperlinks can be added or deleted using the context menu (right-click) of the 

Links text field or they can be added or deleted by clicking the ( ) or the ( ) 

button. Enter a hyperlink in the Address field, or select a file. 
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In the Hyperlink dialog, you can enter the following information: 

 

SemTalk Hyperlinks are also Visio Hyperlinks therefore links they can be directly opened 

from a diagrams. 

                               

NOTE:  You can directly add hyperlinks by dropping and dragging links from you Internet 

browser.  Using the Data -> Hyperlink paperclip option from the pull-down menu you can 

quickly edit Hyperlink data. 

 

  



  SemTalk Tutorial 

 Email: support@semtalk.com   15 

Read Only Marks the class as read only and protects it from editing or deletion. 

Address Use to add a Web site's URL, starting with the protocol (such as http://) or type 

the path of a local file (a file on your computer or network) that you want to link. 

Alternatively, click  to locate the file or Web site. 

Subaddress If the text field Address is empty, it displays a linked page in your SemTalk model. 

If you enter the path of a local MS Excel file or a Visio file in the Address text field, 

you can name a location (e.g. an Excel Worksheet or a Visio page) as the target 

associated with the specified file.   

ExtraInfo Use this argument to specify additional information that HTTP requires to resolve 

the hyperlink. The most common uses for this argument are to send a Web server 

the contents of a form, the coordinates of an image map, or a search parameter 

for an ASP file. (Example: Address: http://www.google.com/bin/search ExtraInfo: 

?q=keyword) 

Label Use to replace the hyperlink character string with text of your choice. 

Language If you are working with multi-languages models, choose a language(s) that relates 

to the hyperlink target. For example, if you want to link a document explaining 

the tasks of the bank treasurer in different languages and the link has been 

translated to English and Spanish you may attach different documents for each 

language. 

Type You can define classes of attached documents such as job descriptions, pictures 

etc. These classes are defined as subclasses of the class “Attachment” 

Frame A HTML Target frame where the document will be opened 

New Window The document will be opened in a new (Browser-) Window 
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Attributes 

The attributes of a class can be defined and edited in the Attributes tab. Some Visio-Shapes already 

have attributes. You will be able to use them, but now you are also able to edit them or just delete 

them.  

 

Please create the attribute “Address” by pressing New. 

  

Double click or press the Edit button to open the attribute details dialog box. The button Delete is 

intended to delete an attribute. Value is a convenient way to enter a larger piece of text into an 

attribute value. 
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Type Specifies the type of attribute.  Available attribute types are: Symbol (string), File 

(uses external file), Date, Duration (time), Float, Integer (a number between a range 

of numbers) and Boolean (true/false) 

Selecting an attribute type is not required.  

Value The default value (value range) for this attribute. 

Is List Allows the use of multiple valued attributes. E.g. “red” and “green”. 

Options Specifies the options for values of that attribute e.g. “red”, “green”, or “blue”. Those 

options will be used as options for the values combo box. 

After closing this dialog box, the value is shown in the right part of the attribute list. 

 

Once attributes are defined, they are available for use in other objects so you will not need to 

redefine the same attribute for each object class. The actual value, or range of values, must be 

redefined every time an attribute is used for a new class.  

NOTE:  "System" attribute are special predefined attributes that can also be edited. 

NOTE:  When "SubClassOf" connector classes (see shape-set "CLASS") or subclass / superclass are 

connected, attributes are inherited with their values to their subclasses. For further information, see 

"Connections". 
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Language 

With SemTalk it is possible to create multi-language models.  Every class, association class, instance, 

attribute or method can be given different names in any language. SemTalk supports Unicode 

characters, which means that it supports Chinese, Arabic, Japanese and other character based 

language types. 

Open the edit dialog for the class “User” and go to the tab Language and press the New button.  The 

following dialog will appear. 

 

Enter the term “Benutzer”, which means “User” in German. Select “German” from the Language 

combo box or enter a new Language. 

 You should now see the following dialog as result: 

 

By changing the current display language, you can switch between all used languages: 
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     Vs.   

Associations:  Connecting Objects 

Now we will create relationships between objects.  

The easiest way to create connectors is to use the "automatic connector" tool ( ) found 

in the Home toolbar. The Associations tab of the class or instance editor shows the object’s 

associations and they can be edited there. Nevertheless, the easiest way to create, edit or remove an 

association is to do it graphically. In order to do this, we will add additional classes to this example.  

 

From the “Work Flow Diagram Shapes”, drag & drop the “Product” shape into your drawing area. 

A class can have subclasses that represent concepts that are more specific than the superclass. The 

“subClassOf” association defines a taxonomic (subclass – superclass) hierarchy. Adding relationships 

is quite simple.   

Drag & drop the “subClassOf” shape somewhere in the drawing area or by clicking first over the 

Connector Tool   on the menu bar and then clicking over the “subClassOf” shape in the CLASS 

Stencil. 
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If you pull the end-point of the arrow over an object’s “connections point”, you will notice that you 

can glue the relationship to that object. With the “Connector Tool”, you just click over the two 

shapes you want to relate. You can do it more than one time consecutively. A green coloring tells you 

if the connection was successful. Select an end-point and glue your new relationship to the objects of 

your choice. Notice that in case of the “subClassOf” relationship the arrow points toward the 

superclass. 

NOTE: Object names are always singular. It is not recommended to use the class “Users”, since the 

Class “User” already describes one or more Users. 

In our model, “Expert” became a subclass of “User“. It inherited the attributes of “User”, but you can 

now add further attributes to “Expert” (e.g. Domain) or change the values of inherited attributes 

using the Edit button. In the same way, “User” is a subclass of “Person”.  Now add the attributes Age 

and Gender. 
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Inherited attributes are characterized by a “*”. If you change the value of inherited attributes, 

SemTalk’s object engine creates a local copy of the attribute.  This copy will be deleted when you 

delete (reset) its value. 

Now create instances of your classes and call them "John Doe" and "Mary", you will see that each of 

the instances inherits the associated class attributes. You can now click on each instance to specify an 

age for the each of your users.  

If you use the "UML Class" shape instead of the generic "Class" shapes, attributes are defined by 

predefined class attributes that are predefined in the shape. "Select Object → Master" you can later 

select a different shape or switch between defined shapes for classes. 

Please look at the Model Explorer.  Below “Objects”, you will see the inheritance hierarchy.  In the 

tree structure is the contents of the chart "My Classes" (the name can be later changed) listed. By 

"objects" you will see the inheritance hierarchy. This is a view on how the classes are defined along 

with the inheritance relationship (subClassOf, "is a", "Upper Class") in a tree structure.  

Please create a new relationship using the template "property" (in the template "CLASS"). Define a 

new association between "person" and "product". "Used" as the name of the relationship type. 

 

Associations can be made graphically using the “Property” connector.  After adding a connector, you 

will be prompted to create a name for your association.  Define your new association between 

“User” and “Product” as “uses”. 

Relationships between objects are "associations".  Associations appear on the tab and can also be 

changed there. In SemTalk attributes (properties) and associations (relationships) are two different 

objects2.  A property is usually descriptive text or a number (e.g. name, age, etc.), while an 

Association shows the relationship to another object (eg "used"). 

 

                                                           

2 In OWL this is the Data Properties for Attributes and the Object Properties for Associations. 
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Draw another association between "Expert" and "Premium product" the previously created 

association "used" is already available in the combo box as a selection option. If you select 

"superclass" and "subclass", inheritance relationships are created instead of associations. 

 

NOTE FOR VISIO 2007 AND VISIO 2010: 

 

As Visio 2007 users may have already noticed, Visio offers a new tool to connect neighboring shapes. 

As the figure shows, you can choose one of the blue arrows from the origin shape (just move the 

mouse pointer over it) and Visio will mark red the next neighboring shape. Click on the blue arrow to 

confirm the selection and SemTalk opens the association dialog box immediately after. Visio 2010 

has “Quick Shapes” which to allow a very fast construction of a diagram without drag & drop. 

Associations can also be made without using graphics using the Associations tab. 
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If you open the Edit dialog box for “Product” and select the Associations tab, you will notice, that the 

relationship is named “inv uses”. “inv” means that it is the inverse relationship and the inverse name 

of “uses” has not been defined yet. If you right-click on a link and choose Edit you can edit the 

properties of the association.  Edit the relation class “uses” by right clicking and selecting “Edit Class” 

with your pointer on the connector line. 

 

You can find this class in SemTalk’s Explorer under Associations.  Edit this class and change “inv uses” 

to “used by”. 

 

  



  SemTalk Tutorial 

 Email: support@semtalk.com   24 

Notice the association’s context menu has more options: 

Change Relation Used to change (create a new association or replace it with an existing 

one). The original class association is not erased or modified; it is only 

replaced between the two associated objects. 

Invert Relation Use to reverse the direction of an association. 

Edit Class Use to open directly the edit dialog of the association’s class. 

Browse (Please refer to the Browse function explained later in this tutorial.) 

NOTE: Remove deletes the association from the model.  Deleting using right mouse click Cut or the 

Del-key only removes it from the drawing.  All other SemTalk objects behave in a similar manner. 

You can change the class of instances by using the Class combo box of this dialog box in the Edit 

dialog. 

 

Basic SemTalk Functions 

In the following sections, you will learn about SemTalk basic modeling functions. In some cases, 

examples in this tutorial require supplementary models to illustrate functions.  When external 

models are available from our website, their URL will be provided. 

Saving a Model 

Please use Save or Save As. In addition to Visio’s VSD file, a XML file for the model is created. You 

may turn off saving of XML files via SemTalk->Options. Internally SemTalk saves an XML regardless. 

The external XML is only used for referencing objects from other models. If the XML file gets lost, it 

does not matter since SemTalk creates a new XML file every time you save. 

You can use Visio's AutoSave from the Visio options. 

If you use SharePoint Integration, you may directly save into SharePoint document libraries.  
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Comments 

In order to display a comment / definition of an object drag & drop the “Comment” shape in the 

drawing area and point with the “definition of” connector to one or more objects: 

 

By double-clicking on the comment shape, the object’s Edit dialog will open. 

 

Changing the language for the comment allows you to maintain comments in multiple languages.  
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Insert Objects 

You can easily insert existing Classes in new diagrams with SemTalk. Please create a new class 

diagram. Then right-click on the drawing area and choose Insert (Model) to insert existing classes 

into the new diagram. Alternatively, you may use the menu Diagram  Insert. You will see the 

following dialog box: 

 

Object Filter You can insert classes, relation types or diagram types into generic class 

diagrams. For other diagram types, restrictions may apply. The second 

combo box of the object filter allows filtering by subclasses or instances 

(applies only for Diagram types with a root class) 

Existing The default list contains only objects not shown on the current page.  If 

you check Existing, you can insert those objects again. 

All / Not ReadOnly / 

ReadOnly 

Include classes, which are marked as Read-only or not. Typically, these 

are the elements of a method’s meta model.  

Invisible You can insert only those objects that exist in the model’s object base, 

but are not present in any page. 

Insert all valid 

Relations 

All relations used within the object base are visualized. 

All Selects all the objects in the list at once. 

Master (options) It specifies the shape to use. Default is the shape used until now. UML 

uses a UML-style class shape. Shape searches for a shape master with the 

same name as the class. 

NOTE: You can change the size of the Insert dialog box with your mouse. 
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Expand 

When objects are expanded, diagrams are extended using information that has already been 

modeled.  For example, if a User is associated with a Product, we can add related objects to the 

active diagram based on information modeled in other diagrams. 

Insert the class “User” in a new diagram and right-click Expand on the class. Alternatively, you may 

use the menu Object  Expand. 

 

Select “uses” and press OK to insert the class “Product” in the diagram. 

For the expand options see “Insert” 

Browse 

Using the Browse command in the context menu (right-click on an object), allows you to navigate to 

other visualizations of that object. Alternatively, you may use the menu Object  Browse. 

The upper list box shows all diagrams that have a node for the object. The lower list box shows all 

diagrams that have a node with objects having a relationship to the object. 

 

Select an object to show the object in different diagrams. To navigate to related objects, double-click 

on the object you want to see. By checking / deselecting the options Super, Sub, Relation and 
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Instance, you can filter the objects in the lower list box. Objects with compose is used for Business 

Process Modeling only. 

Find 

The command Find is located on the context menu of the drawing pane or in the SemTalk menu. 

With Find, you can search objects displayed on your diagram and navigate to them. 

 

Name The string to match. Blank “Name” matches every object. 

Begins with Searches only for objects where the name starts with the string in Name. 

Match case Used to carry out a case sensitive search. 

Match whole word Used to find the whole string only enter in Name. 

Find Used to begin searching. 

Find in Files Used to search a string in local SemTalk model xml files. 

Show Go to the object’s location in the model. 

Edit Opens the selected object’s edit dialog. 
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Object Properties Searches the object’s properties  

Object Types Searches kinds of objects 

Look for files in subfolders Used to search subfolders of the selected folder when using 

the Find in Files command. 

The tree view shows the matching objects and corresponding type. You may double-click on the 

object or use Show to go to the object. 

Remove 

The Remove command on the context menu (right-click on a node) will delete the object or 

relationship from all diagrams in the model. Alternatively, you may use from the tool bar the menu 

Object  Remove.  

 

NOTE: Objects that are not displayed in any diagram can only be deleted from the model using the 

model explorer or Remove Multiple command. Select the object in the explorer and use Delete from 

Model. 
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Remove Multiple 

The command Object  Remove Multiple gives you the opportunity to remove more than one 

object at once. 

 

When you are working with a specific modeling method (e.g. process modeling methods), the combo 

box Class acts as an information filter.  

Because this dialog is able to remove several objects at once, it is not possible to use the Undo 

command. Select the Delete button to execute the removal of the objects. 

Unify 

Select the Object  Unify menu to combine two objects.  The “Object to keep” will inherit every 

relation, attribute and visual representation of the other object and the “Object to be removed” will 

be removed from the model. 
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Refine / Detach 

 

The right-click command Refine attaches a diagram to an object. You can also use Object  Refine.  

If the object has a refinement, Refine will open the corresponding diagram immediately because it is 

a kind of hyperlink navigation.  

You can navigate back from the refinement to the refined object using Diagram  GoUp or selecting 

GoUp from the context menu of a diagram (by right clicking on the drawing area of a diagram). 

 

NOTE: Objects having a refinement are highlighted with underlined text. 

The External button assigns a diagram in another SemTalk model. 

NOTE: The diagrams are attached to the object, not to its visualization. This implies that the object is 

refined in all diagrams. 

The resulting refinement tree is reflected in the SemTalk explorer: 
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The command Detach removes the link to the diagram, but not the refined diagram itself. 

External  Model 

There are different ways to insert external models in a SemTalk model.  Next, we explain two 

alternative ways to insert external objects in SemTalk models. 

Load Individual External Models 

In order use external objects in a SemTalk diagram, an external model must be loaded first. Loading 

an external model is very easy.  
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Choose File to select a local file from the folder for a directory containing XML files or URL for a 

model saved to the internet. You do not need the Visio file or HTML file for this operation.  

For the purpose of this tutorial, we created an “Urban areas” model to be imported 

http://www.semtalk.com/pub/urban.xml. You can use URL to reference it. 

Once you have opened the XML file, SemTalk’s Explorer should look like this: 

 

As you can see, the explorer contains new grey colored objects. These objects exist in the “to-be-

imported” model. Until now, they exist only virtually in the “urban” model. To make them part of 

your model you have to import them. There are three ways to do this: 

• Drag & drop the object(s) in your diagram. 

• Mark the grey colored object from SemTalk Explorer and select from the menu bar Object  

Import 

• Right-click over the grey colored object in SemTalk Explorer and select from its context menu 

Object  Import 

http://www.semtalk.com/pub/urban.xml
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Please insert the classes “Building” and “City”. Please notice that the objects inserted can only use 

the Default or UML shapes. 

Load multiple External Models 

Frequently users work with more than one source of external objects.  Imagine the following 

scenario - you are working on common model of concepts from different departments in your 

company. The model files are stored in your company’s intranet and on the internet. You need to 

constantly visualize relevant objects from the rest of your organization. 

To accomplish this task, you might want to load several external models to your working model at 

once. To do this, select from the menu options Options  SemTalk Options  Ext. Models (Tab). 

You should see now the following dialog: 
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File Use to add local files (in your hard disk or intranet) to the external models 

list. 

Folder Use to add a folder of files (in your hard disk or intranet) to the external 

models list. 

URL Use to add URL address (xml file of the model published in the Internet) to 

the external models list. 

SharePoint Use to add files located in a SharePoint Services Workspace to the external 

models list. 

SharePoint List Use to add objects defined in a SharePoint list to the external models list. 

Remove Use to remove any link or path in the external models list. 

Open /Save Open or Save the list of external models to a file. 

Refresh Lookup and update all references to external files. This is important after 

copying complete SharePoint site with references to SharePoint list. 

Always show 

external objects 

Use external objects in SemTalk dialogs. (Instead of pushing the “External” 

Button). Objects are imported/referenced as soon as they are used. 

Translate external 

objects 

Translates all objects from external models. Uncheck this option for large 

external models if you know that they are single language. 

Refresh objects on 

starts 

Updates all references to external model on startup. 

 

Delete multiple objects 

In, for this tutorial used, basic SemTalk you have the option to delete multiple objects with the 

assistance of a single dialog. (Objects  Remove Multiple) In other methods will be filtered from 

system classes, tasks and physical resources and gives you the option to delete not used objects. 
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Edit a diagram 

Please select a diagram and right-click the option Edit. You may also use SemTalk  Diagram  Edit.  

 

Name The name of the diagram. 

Class The Diagram Class (or diagram type).  Diagrams are also SemTalk objects.  New 

Diagram Classes may be processes or product models. Details on how to create a 

new Diagram Class are found in a later in this tutorial. 

Type Specifies the type of object displayed in this diagram. There are Class Diagrams and 

Instance Diagrams. 

Visible Indicates if this page is visible in SemTalk, Word Export or HTML Export. The page 

will continue to appear in SemTalk Explorer, in case you need to make it visible 

again. 

 

SemTalk Interfaces 

Most of SemTalk interfaces depend on the modeling method and the template been used.  Almost of 

SemTalk interfaces, options are located under “Open & Import”.   Basic SemTalk interfaces are 

explained later in this tutorial.  For specific interfaces, please check the corresponding methods. At 

the end of this section, you will find a complete list of SemTalk interfaces. 

Import Picture 

Insert Picture only inserts a picture; it does not create a SemTalk object for the picture.  Just copy & 

paste your picture or use Visio’s Insert Options. 
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SemTalk Import 

Use File – Open & Import – Other Imports – SemTalk Import to merge SemTalk models. 

 

Use import to merge complete or partial models. Select an existing model and the following import 

window will appear:  

 

On the left hand side, there is a tree view similar to the SemTalk Explorer where you can select 

objects by diagram or by hierarchy. Additional objects may be imported. On the right side, you can 

preview the page(s) to be imported  

NOTE: Do not try to change anything in the preview. Any changes you may make are not saved. 

Please check those objects or diagrams you want to import and afterwards use FileImport. 
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Select from the Import dialog menu bar Tools  Options to pop-up the import options available, 

which allows specifying some parameters for the import.  

 

Create References / Locations Each object is assigned a reference to the imported file so 

that it can be updated using Object  Refresh. 

Copy Audit Information Audit Information such as Created, CreatedBy are copied 

from the imported model. If this option is not checked, the 

current user and the current time will be used 

Change Diagram class Used to import method-specific ontologies (class models) 

and change the original diagram class. 

Replace Namespace Replace the namespace of imported classes with a new 

namespace 

Paste onto pages which already 

have shapes 

In order to enable incremental import, SemTalk default 

settings do not import pages that already exist or have 

shapes. This means that you cannot import “Process-1” from 

a different document if you also have a page named 

“Process-1”.  

Checking this option will enable copying on used pages 

Center Drawing After import, shapes are centered on the Page. 

SemTalk Import is the best option if you want to import complete diagrams or a large set of objects. 

If you need single objects, Show External Model with Drag & Drop (see section 0) is more 

convenient. 

Semantic Web 

Semantic Web stems from the idea that the Internet is made of data.  Models for the Semantic Web 

are called ontologies. The W3C recommends storing information in the Semantic Web using the 

following protocols: RDF (~Instances), RDFS (~some aspects of classes as you have seen in SemTalk so 

far), OWL (http://www.w3.org/TR/owl-features/, complete description logic). 

What is an Ontology? 

For the purposes of this tutorial an ontology is a formal explicit description of concepts (i.e. classes) 

in a domain of discourse, properties of each concept describing various features and attributes, and 

restrictions on properties and attributes (i.e. relation and data types).  In simple words, an ontology 

http://www.w3.org/TR/owl-features/
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is a formal model for a specific domain of knowledge. An ontology, together with a set of individual 

instances of classes, constitutes a Knowledge Base. 

Ontologies are developed to provide a machine-understandable semantics of information sources 

that can be communicated between different agents (software and humans).  Ontologies are useful 

to: 

▪ share common understanding of the structure of information among people or software 

agents, 

▪ enable reuse of domain knowledge, 

▪ make domain assumptions explicit, 

▪ separate domain knowledge from the operational knowledge and to, 

▪ analyze domain knowledge. 

Web Ontology Language (OWL) is a W3C recommendation for the representation of ontologies. In 

case you want to work with OWL, you should use the OWL Template: File->New and select OWL.vst 

in the SemTalk program directory. In this tutorial, we have used OWL, the SemTalk default notation, 

which is a subset of OWL. 

In SemTalk we use Semantic Web data structures to exchange data in a vendor independent way. 

Any SemTalk model can be exported completely to OWL. SemTalk can import and use OWL 

ontologies as class models for various purposes.   

If you want to use SemTalk as an OWL editor, you should use the OWL template OWL.vst that has all 

the additional constructs, which are needed to cover the complete set of OWL feature.  If you need 

to exploit these features, we recommend using SemTalk in conjunction with Reasoners such as 

PELLET (see Chapter 10 on details for working with OWL).  The following example was created using 

OWL.vst 
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In order to import OWL, RDFS, RDF data select Open & Import Other Imports  Semantic Web.  

 

For example, import the following file: http://www.semtalk.com/pub/veggies.owl  

Additional SemTalk data types are needed.  Standard OWL data types are found in the SemTalk 

program directory. 

NOTE: Instead of importing complete ontologies, you can use Show External Model with Drag & 

Drop (see section 0) and open an OWL file or URL. 

Load Redisplays the contents of the file in the list box 

Links Selects objects related to the current selection in the list box 

Invert Inverts the selection of the list box 

Base Class The common superclass for all object to be imported 

Namespace The default namespace for all object to be imported 

Validate RDF with 

SemTalk Engine 

Only those associations defined at classes are allowed and imported 

Document Information Meta data of the document 

Create References Each object will get a reference to the imported file so that it can be 

updated using Object->Refresh afterwards 

SemTalk Associations and 

Attributes 

If you do not check this option, the import of ObjectProperties will be 

OWL compliant (“has Domain”, “has Range”). If you do check this 

option ObjectProperties will be mapped to SemTalk’ s more UML 

style Attributes and Associations, which make more sense in various 

SemTalk modeling scenarios but screw up the semantics of some 

OWL ontologies. 

 

 

 

http://www.semtalk.com/pub/veggies.owl
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Exporting to OWL or RDFS is quite simple. You can choose to export classes, instances, meta model 
(read only classes) etc. 

 

 

  



  SemTalk Tutorial 

 Email: support@semtalk.com   42 

If you have selected objects in your drawing, only selected objects are exported. 

Remove Local Namespace Ignores the namespaces. This makes sense if you plan to export 

ontologies from process models 

Export Meta Model Export classes marked as “Read Only” 

URN Base namespace for the ontology 

Base Class Only subclasses of selected Base Class 

Prefix Prefix for the base namespace 

Export Document 

Information 

Title, Date, Creator, Subject, Description 

SemTalk Associations and 

Attributes 

If you do not check this option, the import of ObjectProperties will be 

OWL compliant (“has Domain”, “has Range”). If you do check this 

option ObjectProperties will be mapped to SemTalk’ s more UML 

style Attributes and Associations, which make more sense in various 

SemTalk modeling scenarios but screw up the semantics of some 

OWL ontologies. 
 

Microsoft Office Word Export 

Generating documentation of your models is quite easy with SemTalk and Microsoft Office Word.  

Select FileExportMicrosoft Office Microsoft Word 
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On the upper right corner of the dialog, you see a tree view with the existing diagrams in your model 

classified according to their diagram type.  Select which diagrams are to be exported using the 

buttons between the two boxes.  Use the Insert->Add Text File button to insert text files (.doc, .txt, 

etc.) or Insert->Add Reports to add reports into the Word export. The items’ sequence on the list on 

the upper left corner determines the order of the diagrams and text in the Word export. 

Use the File menu option of the dialog, if you want to do the following: 

Load Diagram List Loads a predefined diagram list to generate as Word document. 

Save Diagram List As Saves the current diagram list as .txt file.  You may load this file and 

generate a custom Word export. 

Open Document Template Loads the Word Normal.dot as default template, but you may select 

a custom template with this command. 

More layout options on the Word export dialog: 

Caption Format Defines the heading format according to your MS Word. 

Table Format Defines the layout format of your tables.  

Drawings Includes diagrams in the Word export. 

New Page for Each Diagram Inserts one or more than one diagram in a page. 

Include Background Defines the diagrams’ background (e.g. company’s logo), if 

predefined. 

Include TOC Adds a Table of Contents at the beginning of the Word document. 

Include Text Adds tables to your Word document. 

Include Title Document Title 

Include Cover page Document Title on an extra page 

Generate PDF Automatically generate PDF using Word2007 save as PDF 
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In the Instance and Class tabs, select which object properties and information to include in the Word 

export. 

Microsoft Office PowerPoint Export 

The Microsoft PowerPoint interface makes it easy to present models quickly and effectively.  Open 

the export dialog for PowerPoint using the menu item File → Export → Microsoft Office → 

PowerPoint to generate a PowerPoint presentation from a SemTalk model. You should see the 

following dialog now: 

  

You have the following options: 

Type Filters the diagrams by diagram type. 

Create Title Creates a title for each presentation’s slide that matches SemTalk’s page 

titles. This is not recommend if you have a Diagram background page 

which also shows the page title 

Include Background Adds the diagrams’ background page (e.g. company’s logo), if predefined. 

New Document If this option is not checked AND a PowerPoint presentation is open, the 

slides are added to the open presentation 

 

Microsoft Office MS Excel Import 

The MS Excel Import function is very handy when creating big models with lots of classes and or 

instances. Instead of creating every single class and/or instance in SemTalk, you can import them 

from a MS Excel spreadsheet. The only condition is that the spreadsheet must reflect SemTalk’s 

logical structure. Therefore, an appropriate spreadsheet is included and you may find it in the 

following location: C:\Program_files\Common Files\SemTalk3\bulk-import.xlt. You may create your 

own bulk-import spreadsheets, but you must follow the original Bulk Import structure. 

To import objects from a MS Excel spreadsheet into a model, select from the menu Tools  MS 

Excel. Then select an appropriate MS Excel spreadsheet (e.g. bulk-import.xlt). Once you are ready to 

import the objects and information in the spreadsheet, select from Excel’s menu options Tools  

Macro  Macros. You will see the following dialog: 
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Click on the button “Export”.  SemTalk will export the objects and information to Excel. “Import” will 

import the current elements back into SemTalk. “Clear” will remove all content from Excel. “Process” 

is a sample intended for process modeling notations. It creates a simple process hierarchy from the 

spreadsheets data.  

All macros are included in the document as source code. The intension of bulk import is to provide 

you with an API sample how to read and write SemTalk content. If you copy/edit the macros to 

match your personal ideas you will have a convenient way to export/import mass data from virtually 

any other application. 
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More Export / Imports 

The following is a short summary of export/import options. 

MS PowerPoint Export to MS PowerPoint version 2003 and higher.  

MS Word Export to MS Word version 2003 and higher. 

MS Excel Import from MS Excel version 2003 and higher.. Provides an MS Excel 

sample macro to create SemTalk objects via the SemTalk API. 

MS Project Export and Import to MS Project. Available for CSA (“ksa.vst”), EPC 

(“epc.vst”) and others. 

SAP Explorer Import Solution Maps and other diagrams from the SAP Solution 

Composer (Solution Composer must be installed). Some content of 

the Enterprise Service Repository ESR and Business Blueprints created 

via SAP Solution Manager. At Tools->SAP Explorer 

SAP R/3 4.6c Reference 

Model 

Import processes of the SAP’s R/3 Reference model. A reference 

model database is required which can be obtained from SAP’s Value 

SAP (Asap) CD. Use the template “epc.vst” 

It is at  Open & Import->EPC->SAP R/3 

AML / EPML (ARIS) Import and export of EPC models from other EPC tools such as ARIS 

via ARIS XML using the tool independent standard EPML 

http://www.mendling.com/EPML/  Use the template “epc.vst” 

It is at  Open & Import->EPC->EPML 

BPEL Export of the Web Services format BPEL e.g. for BizTalk. Use the 

template bpmn.vst 

It is at  Save & Send->BPMN->BPEL 

WSDL Import Create object definitions from XML-Schema files / WSDL. To be used 

with BPMN  

It is at  Open & Import->Other Imports->XML Schema 
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Additional SemTalk Functions 

Next we will review additional functions intended to assist you in your creation of comprehensive 

models. 

Working with Visio Stencils 

You may define classes and instances based on Visio masters from any stencil. To open a Visio® 

stencil e.g. File  Open Stencils. In the embedded Version, use File  Shapes to open a stencil. 

NOTE FOR VISIO 2007  

If you are using SemTalk not embedded in Visio 2007 and 

you plan to use regularly Visio shapes, you should define 

the path for the Visio stencils. To do this select from the 

menu bar ToolsVisio OptionsAdvanced (Tab)File 

Paths… (Button). You should now see the following dialog: 

In the text field “My Shapes:” navigate to the directory 

where Visio saves the stencils (e.g. “C:\Program 

Files\Microsoft Office\VISIO12\1033”) (1033 for English 

version). 
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NOTE FOR VISIO 2010 

In Visio 2010 the handling of Stencils has changed. You will open a new stencil now from the Shapes 

anchor window. 

 

New Visio Master 

If you drop a shape on a class diagram, SemTalk creates for each master a class. You may have to 

rename the class afterwards to match your requirements.  If you drop a shape into an instance 

diagram, SemTalk will create an instance for each shape that inherits from the class with the master’s 

name. 

Until now, you have created class diagrams with existing Visio Master Shapes or with abstract 

objects. You have also built instances using Drag & Drop. 

If you want to create new Visio Master Shapes, you have two possibilities. Either copy an existing 

Visio Master Shape or create a new one. It is important to keep in mind that the names of the 

template symbol correspond with the class names in the existing models. Therefore, please copy the 

respective Master Shape, insert it in the Document stencil and rename the symbol (“Master Shape 

Properties” in the master’s context menu). Now, you can use the symbols from the Document stencil 

or create your own stencil to build your models. 

For the purpose of this tutorial, we use the Visio-Master-Shape for “Person 2” as “Manager”. Please 

do as follows: 

1. Open the Document stencil. 

2. Open the “Work flow diagram shapes stencil”  

3. Drag & drop the master “Chief executive officer” from the “Work flow diagram shapes 

stencil” in the “Document stencil”. 
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Rename the master “Chief executive officer” to “Manager” in the Document stencil by right clicking 

on the symbol and select Rename Master from the context menu. 

NOTE: In the stand-alone version of SemTalk you cannot create or graphically edit a Visio master. 

Stencils and masters can only be edited in Visio.  

Please drag a “Manager” and drop it in your instance diagram. Then assign a new name to the new 

“Manager” instance. 

 

Instances, which use the new “Manager” Shape, must stay associated to that particular class. They 

cannot be changed to be instances of other classes such as “Product” 
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If the generic Instance symbol is used, it can be changed to any class.  Please, drag the “Instance” 

master from the “INST” stencil and drop it in the drawing area. 

 

When you create instances with the “Instance” master, you can choose any class you wish to assign 

to the class.  
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Customize 

Customize specifies how objects will be displayed and which tabs will appears in the edit dialog box.  

In addition to the object’s name, it is possible to show any attribute or association value. 

 

Layout specifications are found in Customize (Shape).  They may be overwritten for subclasses or for 

single instances. Please select the Person class from the explorer and select the menu Object  

Customize (Shape) or from the object’s context menu in SemTalk Explorer. In the dialog, select the 

Text tab.  

Text specifies how instances of the class (or its subclasses) are displayed in instance diagrams. Class 

Text specifies how the class itself or its subclasses are displayed in class diagram.  

The left list box shows all currently selected attributes and the right list box shows all possible 

attributes or associations. Use “<” and “>” to add and remove selections. 

In the case of complex shapes, choose “+” and “-“ to show in which sub-shape the value will be 

displayed. You can address up to ten sub-shapes. Multiple attributes may be displayed in the same 

sub shape.  Group specifies that you have selected the whole shape itself (and not a sub-shape). 
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You may use multiple Visio masters with the same SemTalk class (or instances of that class). For each 

master you can specify individually how SemTalk attributes are displayed. 

 

Once you have defined multiple masters for a class, you can switch which master is used in the 

drawing. 
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Customize (Dialog) is used to customize the appearance of the object’s Edit dialog. 

  

Here you can select which tabs to show in the object editor. The check boxes on the left side of the 

dialog box enable or disable SemTalk’s system-defined tabs.  If you were using a specific modeling 

method (e.g. a specific process modeling method), you would see a list of check boxes with the name 

of the method-defined tabs for that method. 
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With Associations you can define new tabs for the dialog which allow to maintain associations to 

other objects in a non-graphical way if they are defined in the meta model. 

1. Define the Association 

 

2. Define the Tab 

 

 

3. Instance Dialog 
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NOTE: In this screenshot you can see the other SemTalk tabs - Methods, States and Language. In 

particular, the language tab is quite useful for specifying alternative names for the object.  The 

SemTalk Find-Dialog also searches for label in different language (“Synonyms”).  

Class Text and Class Edit Dialog are the same for both displaying and editing classes.  

Behavior tab specifies important options regarding how SemTalk manages new instances or 

subclasses of the class. 
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Instances exist on exactly 

one Diagram 

Instances are deleted from the object base as soon as they are 

deleted from the diagram.  

Anonymous Instances This feature is often used for activities in processes. You must have a 

master named as the class. If you renamed an instance of a class, a 

new super class for the instance is created. The instance is not 

individually named. It name is super class name + “.” +ID 

Refinement of Class This is used together with Anonymous Instances.  Refinements are 

attached to super classes and to the instances. e.g. the activity “write 

Book” will be refined by the same sub-process in all processes where 

“write Book” is used 

Create Subclass on Drop Similar to Anonymous Instances but used on classes. Every time a 

class master or class from Explorer is dropped onto as class diagram, 

new subclass is created instead of inserting the class in the diagram  

Hide in Explorer This hides a class so that it will not be shown as a root class in the 

SemTalk Explorer 

Refine Determines if a Refinement is allowed. 

Graphics tab gives you some basic control over how shapes will be displayed without the need of 

changing the Visio master shape 

Color Shapes showing instances of the class will get the specified color 

overwriting the color of the master 

Line Pattern, Line Weight Line Pattern and Line Weight applied to the shapes AND ALL 

Subshapes 

Use Image Allows a bitmap to be displayed in the first sub-shape 
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Associations and Instances 

The property connector is used to define associations between instances.  In connecting two objects 

a dialog box pops up offering possible associations for the object’s class. In our example, an “Expert” 

uses a “Premium Product”, but does not use a “Standard Edition Product”. 

 

We classified our instances following that scheme: 

 

For instances this means that the expert Mary may not use the community edition but John, as a 

standard user may use any product. 

 

You may change the association class of each existing link by right clicking the connector and 

choosing Change Relation. Associations not specified in the class model are generally not allowed 

between instances.  SemTalk Options allow arbitrary associations between instances that have no 

classes specifying associations. 



  SemTalk Tutorial 

 Email: support@semtalk.com   58 

  

By adding classes and associations, SemTalk adds semantics to Visio shapes.  Class models (so called 

ontologies) specify how shapes are assigned to instances. This paradigm allows users to define a 

huge range of modeling scenarios. 

In the Associations tab of the instance edit dialog, you may select an association (property) without 

displaying it graphically.  

Associations are ordinary instances of their association class. You may also define associations on 

associations. 

Note:  For some of the settings to become active, you may need to restart Visio/ Semtalk. 

Association Classes 

Since associations are instances of an association class, they are able to define attributes.  In our 

example, we can add an attribute “arrival time” on the class “works in”, which can then be edited for 

each instance. 
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Add the association class “works in” to the class diagram by right clicking on the background of the 

diagram. Select Relation Type in the type combo box and then “works in” in the list box. 

The class will be displayed in the class diagram. You may now add attributes, subclasses and new 

associations. 

If you need a specific Visio connector for an association class, you can drop a Visio Connector to a 

stencil and rename it to the name of the relationship you want to use. Using the new master shape 

will automatically select the specified relation with the matching name. 

Association Class Options 

Associations not only connect instances with instances, they are also used to connect instances with 

classes and vice versa. 

NOTE: You may edit any object from the Explorer using right-click edit as classes, instances, diagrams 

and diagram classes.  

 

The tab Details presents other options to specify which types of object may be associated (class or 

instance) along with some of their cardinalities. 
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In case of an aggregation, the class’ own relations and its inherited relations will be shown. When 

working with an aggregation, relations of subclasses are added to those from a superclass. 

Aggregation can be understood here as a “is part of” relationship.  Composition is a specific “is part 

of relation” but has no real meaning in SemTalk.  It is simply used to display a diamond on the line. 

No partial objects are deleted if you delete the container. 

With Tree, you prevent cycles. A Transitive relation is e.g. “bigger”. When A is bigger than B and B is 

bigger than C, then A is bigger than C.  In case of Symmetric relations, the inverse name is the same 

as the name.  Multiple means that between two objects more than one relations of the same kind 

are allowed. Unique means that only one relationship of this relation class is allowed to exactly one 

other object. 

Diagram Types 

You may create new diagram types in SemTalk. To create a new diagram type select from the menu 

options Object  New  Diagram Type. 

 

Please enter a name in the dialog to identify the diagram type. 

Do not worry if you do not see the new diagram type in SemTalk Browser. Select from the menu 

options Diagram  New and you should see the new diagram type listed as an option. Click on it and 

you will see the new diagram type and diagram in SemTalk Browser. 

  

You may edit a diagram type to constrain the type of objects allowed on the diagram. This option is 

often used when working with specific stencils making it possible to define what operations are 

available from its context menu, etc.  Select the node in the SemTalk Explorer for the new diagram 

type (in this case “My Diagram Type”) and select from the menu options Object  Edit. Please create 

a new diagram of type “MyDiagramType” because this diagram type will not appear in in the Explorer 

until it is used. 
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Next, select the Diagram tab. You should see the following dialog: 

  

Type Selects Instance or Class diagram.  

Prefix Sets a namespace for new classes derived from the Root Class of 

this diagram type. 

Root Class Sets a class that clusters objects in the diagram type. If the diagram 

type is a Class Diagram, classes on the diagram are subclasses of the 

root class. If the diagram type is set to Instance Diagram, objects on 

the diagram are instances of the root class or its subclasses. The 

goal of the diagram’s root class is to manage objects allowed on the 

diagram. This gives a diagram a context and it is necessary when 

modeling with specific modeling methods.  

Insert Instances Sets classes from which instances are allowed in a class diagram.  In 

other words, instances of the classes are permitted in a class 

diagram. For an example, see section 0 on modeling with OWL.  

Class for new Swimlanes Used in process modeling. Swimlanes usually represents a human 

resource that carries out the tasks placed on the Swimlane. If 

edited, the standard class for the Swimlane may change. 

Auto Select Relation Sets that only a single association is allowed between two classes. 

This association is selected every time a relation is drawn between  

instances of these classes.  

Inheritance SubClassOf Relations are offered on links between two classes 

Metamodel Relations only Only Relations defined on system classes (no namespace) will be 

valid in the diagram 

Stencil Sets which stencils automatically open when the page is visible. 

UML Class Shape Used to set the UML class shape as standard shape when classes 

are created or inserted into a class diagram. 

Edit, Insert, Find, Go Up, 

Refresh, Context Browsing 

Adds options into the diagram’s context menu. 
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HTML Generator 

In order to create an HTML version of your model select from the menu bar Save & Send Save as 

HTML.  

Remember to save your diagram before using the HTML generator. 

 

Title Specifies the name of the Website.  In multilingual models, the next field 

specifies the language in which the Website will be saved.  

Stat page Determines the file path of the Start Page. Do not generate a Start Page to a 

network drive. Always generate to a local directory such as C:\myhtml and 

transfer the html afterwards to the fileserver. 

Select the following options to add elements and functionalities to the HTML export from the 

General tab. 

Goto Page Facilitates a fast navigation across the diagrams. 

Pan Zoom Allows zooming of the diagrams. 

Search Enables search in the website. 

Property Pages Shows the properties of a selected object in a diagram 

Properties (Diagram) Even if Property Pages are not assigned for all objects, you may want a 

Property Page for each diagram for navigation purposes. 

SemTalk Tree Reproduces the SemTalk Explorer in the Website 

VML / Silverlight Specifies how Visio generates graphics 

Language Used to define the language preference for objects attached to the model. 
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The Multi-HTML tab allows you to decide which models to connect to your HTML export. 

Include External 

Diagrams 

Select to generate links to from objects in the to-be HTML model to other 

external HTML diagrams.  NOTE:  When you open the HTML files of the 

external models from a HTML model, all the Start Pages (not the supporting 

files) must be located in the same directory. 

Ext. References in 

new Window  

If selected, external referenced HTML models or documents (e.g. Word 

documents, forms, etc.) open in a new internet browser instance. 

Add files Used to add and search files yourself to the list of files for the multi-html 

export. 

Search files Used to search and to automatically add files referenced in the current 

model to the multi-html list. 

NOTE: The linking of HTML files works only when the index files (i.e. HTML start files) of the linking 

web pages (models) have the same name as their XML files, since the intern referencing uses the 

XML file names of the external models. Please notice that the name of the index file should not 

exceed 38 characters. 
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Under Tree Details, you can choose which object types are to be displayed. Normally, you will want 

to display classes and diagrams but you can also choose associations, attributes, synonyms or 

instances.  

 

Diagrams, Classes, 

Hyperlinks, 

Associations, 

Attributes (Caption) 

Normally, you will want to display classes and diagrams but you can also 

show Hyperlinks, Associations and Attributes. You may also change the 

node name of these objects in the tree view. (e.g. Classes -> Concepts or 

Associations -> Relations). 

Show Refinements on 

Top-Level 

Specifies if diagrams that are refinements of other elements should become 

root nodes in the tree.  If not checked, users have a more hierarchical 

navigation.  If checked, users get a complete list 

Generic Diagrams Often generic (or “Un-typed”) pages display meta models. These pages are 

usually excluded from the HTML representations. 

Show Subclasses on 

Top-Level 

Used to display in the tree view a hierarchical structure (subclass of) for 

each class. 

Instance List Used to display in the tree view a list of instances and no classes. 
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Property Details tab allows you to choose which properties are shown in the property frame in the 

HTML export. 

  

Visible Properties Selects the object properties that you would like to see for an object in the 

property frame in the HTML export. 

Visible Attributes Selects specific properties and associations that you would like to see for an 

object in the property frame in the HTML export.  Simulation and BPEL 

allow you to select a common set of attributes.  Usually only a subset of 

attributes are of interest.  This allows undesired attributes to be hidden. 

Show Comments in a 

Popup Window 

Specifies if an extra menu entry for Comments should be generated. The 

menu will pop-up an extra window showing Comment. 

MouseOver 

Comments 

Specifies if object Comments will be shown if a user hoovers over the 

shape. 
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Use the Hyperlinks tab to edit the path of the referenced objects in the current model. 

   

Find 

Replace 

You may search and replace up to three sub-paths. The button Search 

Hyperlinks will search for existing paths in your model and display them in 

the Find text field. You may replace absolute paths with relative paths 

(“../”). Please remember that the relative path does not begin with the 

“Start Page” directory, but with the subdirectory “xxx files”. The “../” in the 

HTML tag tells the browser to go up one directory level (i.e. to the “Start 

Page” directory in this case.  

Copy Attachments Used to indicate files attached to objects in the model are copied to the 

target directory of the HMTL export. 

New Window for 

Attachments 

Used to indicate that the attached files should be opened in a separate 

instance of your internet browser. 

Popup Window Attachments will open in a limited Popup Window instead of a new browser 

window. 
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Use the Filter tab to select those pages to be included in the HTML export.  

  

Organization unit, 

Buffer 

If a modeling method applies, select one of the options to file the adjacent 

combo box with the corresponding objects.  Select one of the object’s filters 

from the list of diagrams below.  Mark only those diagrams where the 

object is present. 

Diagram Type Select a diagram type filter from the list of diagrams, marking only diagrams 

of that type. 

 

 

The PDF tab allows you to specify that for each page a printable copy in the desired format is 

created.  This simplifies the printing of individual pages. You may choose from Bitmap formats such 
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as WMF, SVG, JPG or use PDF. You can also use Word (Export) to generate the PDF. Please select a 

template for your Use Case. 

Other options are found at the Tools tab. 

 

Other Browsers (Not 

IE) 

Visio generates HTML for IE 6 or higher.  HTML export for other browsers 

have limited functions and generates a large number of small html pages. 

External Start Pages For each object, SemTalk generates an individual Start Page, where external 

models are referenced. 

Sub- Process 

Navigation 

Navigates between lower level diagrams in process models 

Process Path Breadth crumb navigation for process models. You’ll see a shape with text 

REFINEMENTPATH on the background page 

Visio Document SemTalk additionally generates a Visio document with selected properties 

for the Visio Viewer.  SemTalk object attributes are transformed into Visio 

User attributes. 

Support Files Specifies how support files folders are named. “Files” is not an allowed 

name for SharePoint. 

Link to SharePoint 

Viewer 

A menu entry with a link to a specific webpage will be added. The ID of the 

object will be passed as an argument. The intended use is to link elements 

to SharePoint forms 
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The resulting HTML: 

 

Report Generator  

In addition to the above ways to view your business process, SemTalk also offers a comfortable way 

to generate reports about the content of your models. 

To create new reports open SemTalk Report Editor selecting Report  Report Editor.  

With SemTalk Report Editor you can create reports, save and reuse report formats. The tree 

structure shows the logical structure of the query and the attributes included. The right part shows 

the result of the query as XML or as a table. 

In the left combo box, select “User”. The option “All Instances” will list direct and indirect instances 

of User. You can now see the attributes and related objects in a tree view. 

Now select in the tree view User / System Attributes /Name, User / System Attributes / Class, User / 

System Attributes / OnDiagram and uses / Product /Name to see a list of Banks along with the name 

of the treasurer who works there and on which page they are found. 
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The objects, attributes and associations in the model determine the structure of the reports.  Queries 

can be nested into as many levels as you need. 

The XML output can be saved as an XML file, as html table, which can be opened in many tools 

including MS Excel, directly to Excel or to a SharePoint list. 

 

  

Use File  Load Model to specify additional report options.  
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Allows the selection of other models to be included when running multi-model reports. Other 

models will be merged before the report is being executed. Please make sure that you are using 

models with a compatible meta model. 

Extras and Tools 

Table Editor 

Table Editor gives you another way to edit information in your models. You can create and use 

Microsoft Excel tables to visualize and edit information about classes and instances in your models.  

 

Type Used to filter SemTalk’s abstract objects: Attribute, Class, Method, Relation, 

State 

Namespace Use to filter according to namespaces. <None> for classes with no 

namespace. <All> for classes regardless their namespace. 

Class Select a class to see a list of its attributes (if any). <All> to list the attributes 

of every class in the model. 

Diagram Select a diagram as filter argument. <All> to take into account every 

diagram. <None> to list those object that do not appear in any diagram, but 

exist in the object base. 

Comment Check to include the corresponding ‘comment’ in the table. 

Instances Select to generate a table with instances of classes based on a set of filter 

arguments.  

Classes Select to generate a table with the subclasses of the classes you have set as 

filter arguments. 

Export Generates an Excel table according to filter arguments. 

Import Imports the values you changed in the generated table. 

Language Used to translate objects name into different languages and import them 

into the model. 
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You may now edit attribute values in Excel: 

 

Macros 

 

Macro commands allow you to run small SemTalk complementary applications written in a script 

language. 

The example shows three subroutines contained in the file count.vbs. You can open a new macro file 

by clicking Open. Edit will open a script editor (not part of SemTalk). Execute will run the selected 

subroutine. 
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Replace 

 

Replace is used to globally replace strings (rename) in different object properties.  The following 

options are available: 

Name Globally replace the name of an object with another character string. 

Location Globally replace a referenced objects location path with a character 

string.  

Document Path Globally replace the location path of attached files (e.g. documents) with 

a character string 

Namespace Globally replaces the name of an object with another character string. 

Refinement This globally replaces the location of a refinement with another character 

string. (e.g. used after moving the file of an external refinement to 

another directory) 

Substring This checkbox must be checked if you do not want to match single 

documents e.g. changing a directory path 

ReadOnly Include ReadOnly objects 

Check & Repair 

Fix model consistency (e.g. before importing objects from other models or if you are 

concerned that your model is inconsistent) by using ToolsCheck and Repair.  Use caution 

because there is the possibility that some inputs could be lost using this function, especially 

objects that are in Visio and not in SemTalk. 

Cleanup Model (Delete Objects Not Used) 

In the "Tools" Consistency tab there is a „Cleanup Model“ function that removes from the 

model, objects that are no longer used. Not Used means that an object exists as SemTalk 

object, but it is not used on any drawing pages nor is it related to an object currently in use.  

Click on the Cleanup Model icon to open the following dialog box. 
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In the example, there are subclasses that are not used.  If the checkbox is enabled and you 

click the Ok button, SemTalk will delete the objects. 

The same principle applies to all other SemTalk object types. It is also possible to select all 

the object types at the same time and thus completely remove all unused objects. 

SemTalk Options 

SemTalk configuration options are found under the menu command Options (Tools  Options) 

SemTalk Language Options 

In the tab Language, you can specify the language priority for your models. You may specify a neutral 

default language (option “<None>”) to develop a standard version of your model.  In our example 

“English” is specified as our model language.  Languages 1-3 are used to specify alternative 

languages. e.g., Language 1 is English and Language 2 is Medical (as technical language). If there is no 

definition in Language 3, Language 2 is used. If there is no definition in Language 2, Language 1 is 

used.  

 

Object Method and Method Object are used to indicate the semantic order of the name in which 

classes and instances of activities are identified.  For example, in English, an activity would be 

expressed as Method Object [Read (verb) book (noun)], but in German, it is expressed as Object 

Method [Buch (noun) lessen (verb)]. 
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GUI Language System Windows Operating System language 

Current Your Windows’s Language settings. (Check under Start  

Window’s Settings  Control Panel  Regional and 

Language Options) 

Visio Visio’s language settings. (Check under Start  Programs 

 Microsoft Office  Microsoft Office Tools  Microsoft 

Office 200X Language Settings) 

German, English, 

Spanish, Japanese 

SemTalk’s predefined languages 

 

 

Let’s add another language.  Please open the edit dialog for the class “User”. Under the tab Language 

press New enter the German term for user “Benutzer” and press OK. In the next Synonym dialog, 

please enter German as the language. 

 

You should be able to see now on the menu toolbar German as one of the optional languages for 

your model.  

If you are working with multilingual models, it is recommended to choose a non-assigned (“None” 

option) language when developing the first version of your model.  Then add the translations so that 

you can change to a different language to specify the object synonyms in the other language. 
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If you specify “German” as Language 1, every object that has a synonym in German will appear with 

the assigned shape.  The label will be in German, as well as the name in the edit dialog.  

Shortcuts 

If you are using references to external models, namespaces (URNs) can be quite long. In the 

Shortcuts dialog you are able to define namespace shortcuts to be used in all SemTalk dialogs. 

Shortcuts are assigned for the current user and apply to all objects in the current model.  

Using New/Delete/Edit, you can add and assign shortcuts for namespaces used in the current model. 

OWL Import will automatically add all those namespaces and shortcuts found in the OWL file. 
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Explorer 

Explorer options allow you to customize the appearance of SemTalk’s Explorer. Explorer options are 

saved with the model (xml-file). 

 

Show Namespaces Displays the object identifier in the tree view: Namespace#Name 

Show Diagrams Shows the Diagrams subtree. 

Show Generic Diagrams Shows diagrams without a specific user-defined type. These are often 

the meta models. 

Edit Diagram Types Creates, edits and deletes diagram types 

Show Objects Shows the Objects subtree. 

Edit Objects Creates, edits and deletes objects from the browser 

Subclass Hierarchy Show subclasses as an inheritance hierarchy. If you do not select this 

option, classes are listed alphabetically. 

Edit Attributes  Edit and deletes attributes. 

Edit Relations Edit and deletes relation types (association types) 

Associations Shows the Associations subtree. 

Attributes Shows the Attributes subtree. 

Methods Shows the Methods subtree. 

States Shows the States subtree. 

Datatypes Shows the Datatypes subtree. 
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General 

On the SemTalk options General Tab, you can define the following options: 

 

Use SharePoint Integration Optional SemTalk Functions supporting collaborative work with 

SemTalk. 

Simulation This option allows to die the Simulation tab in process modeling 

methods. 

Hours per day Specifies how many working hours a day has. Used in business 

process models and simulation. 

Template / Default Template Defines the template that will be loaded when SemTalk starts. If the 

last template is not available in the current SemTalk model, the 

“Default Template” is used. 

Show Background Pages Background pages are hidden by default. Check this option if you 

need to change them. SemTalk objects cannot reside on 

background pages. 

Save SemTalk XML File Check this option to create an xml file of the current model without 

graphical information. Used to reference models. 

Load SemTalk XML File If unchecked SemTalk uses only the XML stored inside the Visio 

document. 

Always use ‘Compose’ Intended for process modeling. Applies Object  Compose to 

every new activity. 

Open Stencils SemTalk opens the appropriate Visio stencil assigned to the current 

page type. 

Show Language tabs always Language tab is always visible in Edit dialogs without customizing 

each individual class. 

No BottomUp Methods Intended for process modeling. At Object  Compose new verbs 

may be entered that are not defined in a class model. 
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Check for Updates If checked, SemTalk tries to read the current version information 

from www.semtalk.com once every day.  

Upgrade SemTalk2 Changes the way attachments are stored. 

Show Paper Clip at 

Attachments 

Activities/Functions in the process modeling notations will have a 

paper clip if they have attachments. Please note that this only 

works on master”s shapes built on SemTalk’s Activity master 

shapes. 

Underline Refinements Underline the text of objects having a refinement. 

Underline Attachments Underline objects having an attachment. Alternative to the paper 

clip. 

Show Transactions Functions with transaction will get a thicker border. 

Show Language tab for 

Attributes 

This option allows you to specify language specific values for 

attributes. Please note that this is only supported for the 

“Attributes” tab in the Edit Dialog. All other attributes entered e.g. 

in “Measures” tabs are not supported. 

Use Visio’s Undo Function Visio’s Undo is disabled by default, since changes made cannot be 

undone in SemTalk. Undo may be used when repositioning shapes. 

After using Undo a SemTalk consistency check is made. 

Change the System Class of 

Instances 

Instances of system classes cannot be changed to other existing 

classes.  This option will allow you to do this even though it is not 

recommended. 

Do not hide Background 

Pages 

SemTalk automatically hides all background pages as soon as you 

change the active page. This is done so that you do not model on 

background pages. 

Use Root Classes for Compose Compose builds activity names from nouns and verbs. This is done 

via the main business object modeling class (Object or Information 

in CSA).  This option gives you more options in that you can use 

other modeling elements such as predefined physical resources to 

be combined with a verb. 

Sync all Attribute For each value changed in SemTalk, a Visio data attribute will be 

created that holds a copy of the value. This may be used with Visio 

Services. 

Remove Visio Layers Determines if you remove the Visio Master layers in SemTalk. 

Unrestricted Instance 

Association 

Allows you to create associations even when it is not allowed in the 

meta model.   

Add to Layer by Mastername Determines if you add the SemTalk layers in Visio. 

Break String SemTalk allows you to pre-define text strings that when the appear, 

will insert line breaks in your text.  E.g.  If you define “- <BLANK>“ to 

be a line break in SemTalk Options, every time a “- <BLANK>“ 

appears in any SemTalk text, a line break will occur. This is 

especially useful when importing EPC because “- <BLANK>“ is the 

standard line break command for ARIS.   

 

  

http://www.semtalk.com/
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Path 

The SemTalk Options Path tab has these settings 

 

Template Dir File directory where SemTalk templates are located and where you 

have at least reading rights. As default, SemTalk saves templates to 

Program Files\Common Fillies\SemTalk. 

HTML Dir File directory where an HTML version of a model with its external 

model objects is located. If this text field is empty, SemTalk uses 

location path of the original XML file of the model to locate the 

HTML model.  

XML Files Store XML files in a specific directory (e.g. a SharePoint folder). 

SemTalk Menu XML file that specifies which menu option will be shown in the 

SemTalk GUI. 

Update Path Specify an alternative location for SemTalk version information. 

Values Types Here you can specify your own value types for attributes. See wss-

stdt.xsd for an example. 

Init Files Specify an alternative VBS file. 

Ext. Models A file that contains a list of external models which are loaded at 

startup time. You may specify an absolute path as a finename 

relative to the opened document. It works locally or in a SharePoint 

library. 

Templates List of available templates in the non-Addin version. 

Ribbon VSTO Visio Ribbon used by the SemTalk Visio 2010 Addin.  
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External Models 

You can predefine a list of external models, so that they are automatically loaded and shown in 

SemTalk’s Explorer when you open a model. 

You will find this feature very useful if you use regularly information scattered in different models. 

For example, you can use organizational charts for your process models or process libraries on a 

regular basis. Next time you create a new model you will not have to load them manually. SemTalk 

will keep the models semantically consistent. 

  

External models can exist as XML files in your local file system, published on the Internet, in a 

SharePoint Workspace or as well in SharePoint lists. You may Open (Load) and save those list to XML 

files. “Refresh” is a special functionality to update references into external lists after they have 

changed locations. 

 

Any SharePoint list can be assigned to any SemTalk Class to be able to use list item as subclasses or 

instances. 
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Using OWL.vst 

Open the OWL template to use SemTalk as an OWL editor . File->New SemTalk and select OWL.vst.  

This tutorial does not intend to teach you how to apply OWL to the modeling of your business needs. 

Please refer to the Spec (http://www.w3.org/TR/owl-features/) or to OWL tutorials out on the web 

(http://www.cs.man.ac.uk/~horrocks/ISWC2003/Tutorial/) to learn about the underlying ideas of 

OWL. 

 

The OWL template contains additional shapes to create OWL Diagrams. An OWL diagram is a class 

diagram, which also allows instances but with more restrictions. The OWL stencil has some additional 

shapes compared to the standard SemTalk class stencil:  

 

The main difference compared to standard SemTalk is, that SemTalk assumes “Closed World 

Semantics” while OWL assumes “Open World Semantics”. “Open World Semantics” assumes that 

every two object can denote the same concept unless someone states that they are different. This is 

crucial for the global vision of Semantic Web. 

  

http://www.w3.org/TR/owl-features/
http://www.cs.man.ac.uk/~horrocks/ISWC2003/Tutorial/
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For everything ignored by SemTalk, you could also use a reasoner. For SemTalk you might use PELLET 

as a reasoner (OWL->Reasoner): 

 

equivalentClass Two classes actually denote the same concept. 

Ignored by the SemTalk Engine but exported to 

OWL. 

disjointWith Instance is not allowed to be an instance of 

both classes. Ignored by SemTalk Engine but 

exported to OWL. 

Instance Just an instance. 

instanceOf Graphically displays that the object is instance 

of a class. An instance can be instance of 

multiple classes. Supported by the SemTalk 

Engine.  

sameIndivudualAs, sameAs Two instances denote the same object. Ignored 

by the SemTalk Engine, which assumes closed 

world semantics 

differentFrom Two instances are denoting different objects. 

Default for SemTalk. 

OWL Union An abstract class describing the union of a set of 

other classes. Use the unionOf relation to 

specify that set. Ignored by SemTalk Engine but 

exported to OWL. 

unionOf Relation from a OWL Union class to other 

classes. 
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OWL Intersection An abstract class describing the intersection of 

a set of other classes. Use the intersectionOf 

relation to specify that set. Ignored by SemTalk 

Engine but exported to OWL. 

intersectionOf Relation from a OWL Intersection class to other 

classes. 

OWL ComplementOf An abstract class describing that instances of 

the class are not instance of another class. Use 

the complementOf relation to specify that 

other class. Ignored by SemTalk Engine but 

exported to OWL. 

complementOf Relation from a OWL ComplementOf class to 

other classes. 

OWL OneOf An abstract class that describes that instances 

of that class are one of a set of other instances. 

Use the oneOf relation to specify that set. 

Ignored by SemTalk Engine but exported to 

OWL. 

oneOf Relation from a OWL OneOf class to instances 

defining that class. 

OWL AllDifferent Operator specifying that all related instances 

are different. (Default in SemTalk) 

distinctMember Member of an AllDifferent Set. 

AttributeType Graphically displays an Attribute Class. 

(“DataProperty” in OWL) 

RelationType Graphically displays an Association Class. 

(“ObjectProperty” in OWL) 

equivalentProperty Two AttributeTypes or RelationTypes have 

same meaning. Ignored by SemTalk Engine but 

exported to OWL. 

subPropertyOf Subclassification of properties. Partially 

supported by SemTalk Engine but exported to 

OWL. 

hasDomain Relation from a property to its domain. This can 

also be specified using the edit dialog Details 

tab. Supported by the SemTalk Engine. 

hasRange Relation of a property to its range. This can also 

be specified using the edit dialog Details tab. 

Supported by the SemTalk Engine. 
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Options 

The Help command provides the user useful functionalities.  

Index Opens a short menu reference in HTML format. 

Tutorial Opens this tutorial from the www.semtalk.com. 

Check and Repair Checks the consistency of a model and repairs any detected inconsistency. 

This function deletes corrupt information and objects that are inconsistent. 

Check Connectors Checks to see if the selected connector is attached to objects. 

Update refinement 

path 

Updates the breadth crumb navigation. 

Redraw and Rebuild 

Menus 

Rebuilds menus after the import of SemTalk 1 models. 

Rename pages to 

Current Language 

Sets the names of the pages of a multi-language model to the current 

modeling language. 

Registration Registers your SemTalk license (SemTalk Key). 

Startup Screen Opens SemTalk’s initial screen and provides information on SemTalk 

modeling methods. 

Install Visio COM-

Addin 

Installs SemTalk Addin for Visio 

Check for Updates Verifies if new versions and/or hot fixes have been released. 

About SemTalk Version and license info 

 


